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前言 

感谢选用 SOFTLINK 控制器 

为回报客户，我们将以品质一流的运动控制器、完善的售后服务、高效的技术支持，帮

助您建立自己的控制系统。 

SOFTLINK 产品的更多信息 

SOFTLINK 的网址是 http://www.softlinkcloud.cn 。在我们的网页上可以得到更多关于

公司和产品的信息，包括：公司简介、产品介绍、技术支持、产品最新发布等等。 

您也可以通过电话（4006-300-321）咨询关于公司和产品的更多信息。 

技术支持和售后服务 

您可以通过以下途径获得我们的技术支持和售后服务： 

电子邮件： info@softlinkcloud.cn 

电    话： +86-021-54708786 

发 函 至： 上海市闵行区东川路 555 号 4 号楼一层 

 上海固高欧辰智能科技有限公司（总部） 

邮    编： 200241 

用户手册的用途 

用户通过阅读本手册，能够了解iDEABOX Pro运动控制器的基本结构，正确安装运动控

制器，连接控制器与电机控制系统，完成运动控制系统的基本调试。 

用户手册的使用对象 

本用户手册适用于具有硬件基本知识且对控制有一定了解的工程人员。 

用户手册的主要内容 

本手册由五章内容组成。详细介绍了 iDEABOX Pro 运动控制器的组成、安装、连线、

调试、电气参数、故障处理等。 

相关文件 

关于 iDEABOX Pro 运动控制器编程，请参见随产品配套的《iDEABOX Pro 运动控制器

编程手册》。 

关于 iDEABOX Pro 运动控制器配置文件及配置工具，请参见随产品配套的《EtherCAT

配置文件&配置工具 EtherCATConfig 使用说明》

http://www.softlinkcloud.cn/
mailto:info@softlinkcloud.cn
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第1章  概述 

1.1  简介 

iDEABOX Pro运动控制器是一款基于 X86架构、集成运动控制技术和 PLC技术的高性能产品。 

控制器本体提供了丰富的计算机接口，包括 USB口、串口、千兆网口、数字量模拟量 IO接口、EtherCAT

接口、CAN接口和 HDMI接口。除此之外，还可以通过 Glink-I总线接口接入数字量、模拟量、编码器等扩

展模块。其灵活的扩展性和优秀的计算性能，非常有利于现今工业 4.0对设备数据采集、处理以及运动控

制方面的需求。例如通过千兆网口接入高速工业相机，结合运动控制实现带机器视觉的各种智能工业应用。 

1.2  型号说明 

1.2.1  iDEABOX Pro 运动控制器型号 

IBX 1  x  x – x x  x  -xx

IDEABOX Controller

PLC sub Type：

每个控制器分别查表

显示接口:

1:None;

2.eHMI;

3:VGA;

4:HDMI;

扩展说明（option）

PLC Type：

100：IDB-3

133：IDB-E

131：IDB-Pro

 

IBX131(IDB-Pro) 

序号 PLC 完整型号表 描述 

1 IBX131-521-16EC 本体 52 路数字量 I/O 点，EtherCAT 16 轴同步运动控制；不带显示接口 

2 IBX131-521-32EC  本体 52 路数字量 I/O 点，EtherCAT 32 轴同步运动控制；不带显示接口 

3 IBX131-521-64EC  本体 52 路数字量 I/O 点，EtherCAT 64 轴同步运动控制；不带显示接口 

3 IBX131-804-16EC 本体 44路 I/O 点，包含数字量和模拟量，EtherCAT 16 轴同步运动控制；带 HDMI 显示接口 

4 IBX131-804-32EC  本体 44路 I/O 点，包含数字量和模拟量，EtherCAT 32 轴同步运动控制；带 HDMI 显示接口 

5 IBX131-804-64EC  
本体 44路 I/O 点，包含数字量和模拟量，EtherCAT 64 轴同步运动控制；带 HDMI 显示接口 

 

图 1-1 iDEABOX Pro 控制器型号表 
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1.2.2  iDEABOX Pro 运动控制器外形 

 

图 1-2 iDEABOX Pro 运动控制器 

1.3  功能说明 

功能 

控制周期 1ms 

EtherCAT接口功能 

 可接 EtherCAT驱动器（最多 64个），详细说明见：1.4  

EtherCAT轴功能说明 

 可接 EtherCAT扩展模块（数量不限） 

CAN 接口功能 
 可接 CAN扩展轴模块 

 可接 CAN数字量、模拟量扩展模块 

运动程序 在运动控制器上直接运行程序 

本体 I/O 包含本体数字量 I/O和模拟量 I/O 

1.4  EtherCAT 轴功能说明 

功能 

基本运动 S-曲线、梯形曲线、点位运行、Jog运动等 

同步运动 电子凸轮、电子齿轮运动、跟随运动 

PT 运动 位置时间运动模式 

PVT 运动 位置、速度和时间运动模式 

插补运动 直线、圆弧等多轴插补运动 
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第2章  快速使用 

2.1  开箱检查 

打开包装前，请先查看外包装标明的产品型号是否与订购的产品一致。打开包装后，请先戴上 SOFTLINK

给您配置的防静电手套，然后按照《装箱清单》或订购合同仔细核对配件是否齐备。检查运动控制器的表

面是否有机械损伤，如果运动控制器表面有损伤，或产品内容不符合，请不要使用，立即与 SOFTLINK 或

经销商联系。 

iDEABOX Pro运动控制器产品清单： 

(1) iDEABOX Pro运动控制器，数量1台； 

(2) 配套光盘，数量1张； 

(3) 防静电手套，数量1对； 

(4) 保修卡，数量1张； 

(5) 合格证，数量1张。 

以上仅为参考，实物请以随箱《装箱清单》或订购合同为准。 

2.2  安装场所 

控制器须远离大功率、强电磁干扰的商用电器和环境。 

2.3  准备工作 

在安装之前，请先准备好以下物品： 

(1) +24V直流电源（不允许使用+12V直流电源代替）； 

(2) iDEABOX Pro和驱动器之间相互连接的网线，用户自备（请使用符合TLA/EIA-568标准的STP 

CAT-5E(超五类屏蔽线)线缆或更高等级的线缆）； 

(3) 万用表。 

2.4  安装步骤 

如果用 iDEABOX Pro控制器控制驱动器，则一般操作步骤如下： 

步骤 1：连接电机和驱动器； 

步骤 2：连接运动控制器和伺服驱动器。 
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步骤 3：使用+24V 直流电源给控制器上电； 

步骤 4：建立主机与运动控制器的通讯； 

2.4.1  步骤 1：连接电机和驱动器 

 

为安全起见，建议用户初次使用本控制器时，务必将电机与负载脱离开，在未完成控制系统的

安装、调试前，不要将电机与任何机械装置连接。待调整控制器以及驱动器参数使得电机受控

后，方可进行系统的连接，否则可能造成严重的后果。 

在连接驱动器与电机，请确认驱动器没有与运动控制器连接。用户必须详细阅读驱动器的说明书，确

保正确连接。按照驱动器说明书的要求测试驱动器与电机，确保其工作正常。 

2.4.2  步骤 2：连接运动控制器和伺服驱动器 

关闭电源，使用准备的网线连接iDEABOX Pro运动控制器和伺服驱动器。 

2.4.3  步骤 3：使用+24V 直流电源给系统上电 

iDEABOX Pro 运动控制器为用户提供了标准输入备接口，如 USB 等，用户可将键盘，鼠标等通用输入

设备连接到这些接口上使用。此外用户还需要提供一个 24V、至少 3A的直流电源为其供电。直流电源接到

控制器 POWER接口上，接通后控制器上的电源指示灯亮起，表明运动控制器已上电工作。 

2.4.4  步骤 4：建立主机与运动控制器的通讯 

在此，对于 iDEABOX Pro 运动控制器的用户，请用网线连接运动控制器和 PC 机，然后可以通过在命

令行输入命令 ping去检查控制器与 PC机是否通讯正常，通讯正常后可以进行之后的编程调试 。 
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第3章  硬件资源 

3.1  控制器硬件资源 

iDEABOX Pro(IBX131-804-xxx)控制器硬件规格： 

序号 项目 规格 

1 处理器 Intel x86 2.0GHz，4cores 

2 程序存储器 16GB Flash DOM盘 

3 内部主存储器（RAM） 2GB DDR3 

4 掉电存储 1Mbit铁电 

5 对外接口 

EtherCAT通信接口，RJ45座子 x1； 

标准以太网通信口，RJ45座子 x2； 

COM口，DB9公头 x1； 

CAN口，DB9公头 x1； 

USB Host  x2 

HDMI高清显示接口 x1 

DIx.0-DIx.7，通用数字量输入，4+8x2； 

DOx.0-DOx.7，通用数字量输出，8x2 

AIx.0-AIx.3，可变量程模拟量输入，x4 

AOx.0-AOx.3，可变量程模拟量输出，x4 

6 指示LED 

PWR，电源，黄绿色 x1； 

RUN，运行，黄绿色 x1； 

USR，用户定制指示灯，黄绿色 x1； 

SF，System Failure系统故障，红色 x1； 

BF1，Bus Failure 1（GLINK-I），红色 x1； 

BF2，Bus Failure 2（EtherCAT），红色 x1； 

DIx.0-DIx.7，通用数字量输入指示灯，黄绿色 4+8x2； 

DOx.0-DOx.7，通用数字量输出指示灯，黄绿色 8x2 

7 组态软件 CODESYS V3 

8 操作系统 Linux 

iDEABOX Pro控制器的接口如下图所示： 
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图 3-3 iDEABOX Pro 控制器接口示意图 

 iDEABOX Pro控制器接口列表说明如表 3-1所示 

表 3-1 接口说明 

位置序号 接口标识 功能 

1 EtherCat 标准 EtherCAT 接口 

2 LAN1 以太网接口 1 

3 LAN2 以太网接口 2 

4 USB1 USB 接口 1 

5 USB2 USB 接口 2 

6 CANopen CANopen 信号接口 

7 RS232 通用串行接口 

8 DI0.x 通用 IO 输入 

9 DI1.x 通用 IO 输入 

10 DI2.x 通用 IO 输入 

11 AI.x 通用模拟量输入 

12 24VDC 电源接口 

13 DO0.x 通用 IO 输出 

14 DO1.x 通用 IO 输出 

15 AO.x 通用模拟量输出 

16 HDMI HDMI 接口 

17 EXT IO 外部 IO，Glink-I 总线接口 

3.1.1  电源接口(24VDC) 
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PE PE M M L+ L+

24VDC

1 6
 

图 3-4 电源接口引脚定义 

 

表 3-2 电源接口定义 

引脚 信号 说明 

1 PE 保护地（连接大地） 

2 PE 保护地（连接大地） 

3 M +24V参考地 

4 M +24V参考地 

5 L+ +24V输入 

6 L+ +24V输入 

 

3.1.2  通用数字量输出接口 

 

图 3-5 通用输出接口引脚定义 

 

表 3-3 通用输出 0 接口定义 

端子 引脚 信号 说明 引脚 信号 说明 

DO0.x 

1 L0+ DO0+24V 输入 2 M0 DO0+24V 参考地 

3 DO0.0 通用输出 4 DO0.1 通用输出 

5 DO0.2 通用输出 6 DO0.3 通用输出 

7 DO0.4 通用输出 8 DO0.5 通用输出 

9 DO0.6 通用输出 10 DO0.7 通用输出 

DO1.x 

1 L1+ DO1+24V 输入 2 M1 DO1+24V 参考地 

3 DO1.0 通用输出 4 DO1.1 通用输出 

5 DO1.2 通用输出 6 DO1.3 通用输出 

7 DO1.4 通用输出 8 DO1.5 通用输出 

9 DO1.6 通用输出 10 DO1.7 通用输出 
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图 3-6 通用输出接口内部电路 

 

3.1.3  通用数字量输入接口 

 

图 3-7 通用输入接口引脚定义 

 

表 3-4 通用输入接口定义 

端子 引脚 信号 说明 引脚 信号 说明 

DI0.x 

1 . 悬空 2 DI0.0 通用输入 

3 DI0.1 通用输入 4 DI0.2 通用输入 

5 DI0.3 通用输入 6 MI0 DI0.x 公共端 

DI1.x 

1 . 悬空 2 DI1.0 通用输入 

3 DI1.1 通用输入 4 DI1.2 通用输入 

5 DI1.3 通用输入 6 DI1.4 通用输入 

7 DI1.5 通用输入 8 DI1.6 通用输入 

9 DI1.7 通用输入 10 MI1 DI1.x 公共端 

DI2.x 

1 . 悬空 2 DI2.0 通用输入 

3 DI2.1 通用输入 4 DI2.2 通用输入 

5 DI2.3 通用输入 6 DI2.4 通用输入 

7 DI2.5 通用输入 8 DI2.6 通用输入 

9 DI2.7 通用输入 10 MI2 DI2.x 公共端 
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图 3-8 输入 I/O 接口内部电路 

3.1.4  通用模拟量输出接口 

A0 G A1 G A2 G

AO.x

1 10

A3 G NC NC

 

图 3-9 通用模拟量输出接口引脚定义 

 

表 3-5 通用模拟量输出接口定义 

端子 引脚 信号 说明 引脚 信号 说明 

AO.x 

1 A0 模拟量输出通道 0 2 G 模拟量参考地 AGND 

3 A1 模拟量输出通道 1 4 G 模拟量参考地 AGND 

5 A2 模拟量输出通道 2 6 G 模拟量参考地 AGND 

7 A3 模拟量输出通道 3 8 G 模拟量参考地 AGND 

9 NC 预留 10 NC 预留 

 

3.1.5  通用模拟量输入接口 
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A0 C0 A1 C1 G A2

AI.x

1 10

C2 A3 C3 G

 

图 3-10 通用模拟量输入接口引脚定义 

 

表 3-6 通用模拟量输入接口定义 

端子 引脚 信号 说明 引脚 信号 说明 

AI.x 

1 A0 模拟量输入通道 0 2 C0 通道 0 串联电阻 249Ω接地 

3 A1 模拟量输入通道 1 4 C1 通道 1 串联电阻 249Ω接地 

5 G 模拟量参考地 AGND 6 A2 模拟量输入通道 2 

7 C2 通道 2 串联电阻 249Ω接地 8 A3 模拟量输入通道 3 

9 C3 通道 3 串联电阻 249Ω接地 10 G 模拟量参考地 AGND 

 

 

A0

C0

A1

C1

G

A2

C2

A3

C3

G

249Ω

A
D

C

249Ω

249Ω

249Ω

I

V

+
-

+

-

 

图 3-11 模拟量输入接线图 

 

 模拟量输入信号可以是电压型或电流型。 电压信号输入时，信号正极连接 Ax 端子，信号负极连

接 AGND； 电流信号输入时，把该通道的 Ax 端子和 Cx 端子连接在一起，信号正极连接 Cx 端子，

信号负极连接 AGND。 
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3.1.6  指示灯说明 

PLC使用 5个系统 LED指示灯显示以下系统状态：PWR、RUN、SYSTEM Failure、BUS Failure1、BUS 

Failure2。其中 LED指示灯的颜色分配及状态说明如下表所示。 

表 3-5 LED 指示灯工作状态说明 

序号 名称 功能 颜色 说明 

正常

运行

状态 

1 PWR Power，电源 黄绿 
点亮：CPU电源正常； 

熄灭：电源异常。 
点亮 

2 RUN 
应用程序运行

状态 
黄绿 

点亮：PLC应用程序运行中； 

闪烁：PLC应用程序加载或者擦除中； 

熄灭：PLC应用程序停止，或内部无应用程序。 

点亮 

3 USR 用户状态灯 黄绿 用户定制。 -- 

4 SF 

System 

Failure， 

系统故障 

红色 

运行过程SF灯状态说明： 

熄灭：系统运行正常，没有任何故障产生； 

闪烁：任何故障发生，出现闪烁。必须排查故障，重

启PLC程序。SF灯闪烁可能原因： 

1） IO模块故障，对应的 BF1指示灯会点亮 

2） EtherCAT总线故障，对应的 BF2指示灯会点亮。 

熄灭 

5 

 

 

BF 1 glink总线故障 红色 

熄灭：总线工作正常，或未启用； 

点亮：glink总线故障，实际硬件组态与应用程序组

态不一致，或者有模块工作异常。 

熄灭 

6 BF 2 
EtherCAT总线

故障 
红色 

熄灭：总线工作正常，或未启用； 

点亮：EtherCAT总线组态（Configuration）故障，

实际硬件组态与应用程序组态不一致，从站断线，或

者有从站工作异常； 

熄灭 

7 
DIx.0-

Dix.7 

通用输入指示

灯 
黄绿 

MI0/1/2/3连接24V：输入低电平指示灯亮； 

MI0/1/2/3连接0V：输入高电平指示灯亮； 
 

8 
DOx.0-

DOx.7 

通用输出指示

灯 
黄绿 输出高电平指示灯亮；  

EtherCAT 和 Ethernet 通信指示使用 RJ45 插座集成的黄绿色 LED 显示。 

表 3-6 EtherCAT 指示灯说明 

序号 名称 功能 颜色 

1 ACT EtherCAT通信指示灯 绿色 

2 LINK Link连接 黄色 

表 3-7 Ethernet 指示灯说明 

序号 名称 功能 颜色 

1 ACT Ethernet通信指示（Active） 绿色 

2 LINK Ethernet通信指示（Link） 黄色 
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3.2  常规技术参数 

环境条件——运行 

操作温度 
水平安装 0 to 55 °C 

垂直安装 0 to 45 °C 

相对湿度 95%无凝结 

大气压 1080 至 795 hPa（相当于海拔 -1000 到 2000m） 

振动和冲击 

机械冲击 EN 

60068-2-27 
15 G，11 ms 脉冲，3 个轴向上 6 次冲击 

正弦振动 EN 

60068-2-6 

DIN 导轨安装： 5-9 Hz 时 3.5 mm，9 - 150 Hz 时 1G 

面板安装： 5-9 Hz 时 7.0 mm，9 - 150 Hz 时 2G 

每个轴 10 次摆动，每分 1 倍频程 

环境条件——运输/储存 

运输/储存温度 -20 to 70 °C 

大气压 1080 到 660h Pa（相当于海拔 -1000 到 3500m） 

自由落体

EN60068-2-32 
0.3 m，5 次，产品包装 

相对湿度 最大湿度 95% 

电磁兼容性(EMC) 

静电放电 

EN 61000-4-2 

±8 kV，对所有表面的空气放电 

±4 kV，对暴露导电表面的接触放电 

快速瞬变脉冲 

EN 61000-4-4 

±2 kV，5 kHz，到交流和直流系统电源的耦合网络 

±2 kV，5 kHz，到 I/O 的耦合夹 

浪涌抗扰度 

EN 6100-4-5（需外部保护电

路） 

± 2 kV 共模，1 kV 差模 

传导干扰 

EN 61000-4-6 
150 kHz 到 80 MHz，10 V RMS，1kHz 时 80% AM 

传导发射 

EN 55011，A 类 

0.15 MHz 到 0.5 MHz <79dB (μV) 准峰值；<66 dB (μV) 均值 

0.5 MHz 到 5 MHz <73dB (μV) 准峰值；<60 dB (μV) 均值 

5 MHz 到 30 MHz <73dB (μV) 准峰值；<60 dB (μV) 均值 

辐射发射 

EN 55011，A 类 

30 MHz 到 230 MHz <40dB (μV/m) 准峰值；测量距离为 10m 

230 MHz 到 1 GHz <47dB (μV/m) 准峰值；测量距离为 10m 

IP防护等级 IP20  机械保护，EN 60529 
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第4章  软件资源 

4.1  安装软件 

1. 在安装编程软件前，需要在 SOFTLINK 官网下载或者咨询技术人员拷贝相应版本的编程软件。此版本

最新软件包为 CODESYS v3.5 SP9 Patch2。 

 

2. 在打开软件后，即会弹出软件安装向导进入软件安装。如果系统缺少某些组件，则软件界面会提示安

装相应组件，直接点击安装即可。 

 

在安装之前务必关闭杀毒软件，或者在安装过程中信任软件的所有安装功能，否则有可能会导致安装

失败，组件开始安装如下图示： 
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3. 软件必需组件安装完成后，即进入了安装向导，如下图示，选择 Next进入下一步。 

 

4. 进入到 license Agreement 页面，选择接受协议，点击 Next进入下一步。 
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5. 进入安装目标文件夹路径选择界面，目标文件夹默认安装在系统分区，如下图。建议按照默认路径安

装。 

 

6. 在安装组件选择界面中，默认为安装编程软件的所有组件。可以根据需要去选择安装内容，建议全部

安装。 
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7. 在选择程序文件夹中，不需要修改程序文件夹名称，按照系统默认名称点击 Next进入下一步。 

 

8. 进入开始拷贝文件夹界面，选择 Next开始进行程序的拷贝与安装。 
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开始拷贝与安装过程如下图示，软件安装过程可能需要十几分钟。 

 

9. 在安装完成后，会弹出重要信息提示框。选择上面的已读信息选项，选择 Next下一步完成安装。 
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10. 以上步骤完成后，即完成软件的安装过程，点击完成安装界面的 Finish，完成软件的安装。 

 

4.2  软件配置 

1. 软件安装完成后，在桌面上可以查找到编程软件的快捷方式，如下图。双击图标打开软件。 
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软件打开如下图： 

 

2. 在进行编程之前，首先需要安装设备的描述文件。设备的描述文件可以在 SOFTLINK 官网下载，或者

咨询技术人员提供。 

目前 iDEABOX Pro 的设备描述文件有： 

iDEABOX Pro Target.devdesc.xml     核心板设备描述文件 

GoogolProIO-xxx-xxx.devdesc.devdesc.xml   IO 版设备描述文件 

后续如果有其他更新文件请参考更新文件描述。 

3. 选择菜单栏中的工具选项，弹出下拉菜单，选择菜单中的设备库选项，如下图示： 

 

4. 选择设备库后将弹出设备库安装对话框，如下图。 
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选择“安装（I）…”，在以下弹出的打开窗口中选择核心板的设备描述文件进行安装。 

5. 设备描述文件安装完成后如下图。在设备库中可以查找到已添加的设备。 

 

使用同样的方式安装其他设备描述文件。 

6. 在安装完设备描述文件后即可以新建工程，在工程中进行设备配置。 



第 3 章  硬件资源 

    © 2017 Softlink Copyright 
 

26 

新建工程实例： 

1) 选择菜单栏中的新建工程，弹出新建工程对话框。 

 

在新建工程对话框中，用户可以定义工程名称，工程位置等。 

本实例中，选择创建标准工程，工程名称和路径按照默认设置，确定完成新建工程操作。 

2) 在新建标准工程后，系统会弹出标准工程对话框，在标准工程对话框中选择设备类型及 POU编程

语言，如下图示： 

 

设备类型选择“iDEABOX Pro Target”，PLC_PRG编程语言选择常用的结构化文本（ST）语言。 

3) 新建工程完成后，系统即为新工程分配资源，在编程软件中将创建设备目录，如下图示。到此即

完成新建工程操作。 



第 3 章  硬件资源 

    © 2017 Softlink Copyright 
 

27 

 

4.3  库文件管理 

1. CODESYS V3.5 编程环境提供了丰富的库函数，使用统一的库文件调用接口-库管理器，如下图： 

 

2. 在使用库函数之前，首先需要安装库文件到编程环境下。可以通过库管理器中的资源库选项，或者在

菜单栏中选择“工具”-》“库…”进行安装。 
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3. 选择安装库文件选项，弹出库文件选择框如下图示。在对话框中选择需要安装的库文件。 

 

CmpAMC.library高级运动控制功能库: 

CmpECAT.library:EtherCAT功能库 

CmpSMC.library:标准运动控制功能库 

IoDrvProIO-xxx-xxx.library：本地 IO功能库 

IDBProGL500.library：Glink-I总线功能库 

4. 在库文件安装完成后，即可以在库安装对话框里面查找到相关的库文件，如下图。 
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5. 库安装完成后，可以通过库管理器中的添加库，将库文件添加到工程目录下。 

 

6. 添加完成后选中新添加的库，如下图： 
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选择相应的库文件，则下面会显示该库文件所包含的元素。其中主要包括： 

1) POUs：描述该库文件所提供的所有的程序、功能块或者功能； 

2) Data types：描述该库文件所包含的结构体类型。 

实例： 

在 CmpSMC库文件中，主要包含以下元素： 

在 axis中，包括了基本的轴操作函数，包括轴使能，清状态、轴停止等操作。 

 

在 profile中，包含了常用的运动控制模式操作函数，其中包括点位模式、速度模式、电子齿轮模式、

跟随模式等。 
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在 Data types中，包括了基本运动控制函数需要用到的结构体类型，如下图示。 

右侧为结构体中的元素，分别描述加速度、减速度及平滑系数。结构体类型在运动编程时需要定义相

应的结构体变量再使用。 

 

7. 调用系统库。在 CODESYS V3.5 编程环境中，提供了许多系统功能及功能块，以便于用户开发调用。

按上述方式可以添加系统库至工程中。其中包括常用的运算库、串口通信库、socket通讯库等。添加

方式如下： 
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默认环境下，只显示上述三个函数库。用户可以选择右上角的显示高级库选项。选择完成后，目录下

面将显示其他高级库，如下图： 

 

用户可以用上面的搜索功能，在 System库中或者 Intern库中查找并调用相关函数。 

4.4  使用本地 I/O 

iDEABOX Pro（IBX131-804-xxx）控制器自带 44 路本地 IO，其中包括 20 路数字量输入,16 路数字量

输出，4路模拟量输入以及 4路模拟量输出信号。用户可以通过以下方式使用本地 IO。 

1. 在使用本地 IO前需要先安装本地 IO设备描述文件。在新建工程完成后，即可以在工程中添加本地 IO：

在设备目录树中选择目标设备（iDEABOX Pro Target），然后选择右键菜单-》“添加设备”： 
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2. 在专用设备中，可以查找到 IO板设备描述文件，双击添加到工程中（或者单击选择然后选择右下角

的添加设备）。 

 

3. 添加完成后将显示在设备目录树中，如下图示。双击上一步添加的本地 IO设备 IO_IBX131_804，即可

进入 IO板 Internal配置页面。 

在 Internal 配置页面，可以对模拟通道量程的量程进行配置，如下图： 
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在 Internal I/O映射中，可以查看 IO板对应的物理地址，通道类型，也可以在变量中直接定义 IO

变量名称，方便在程序中 IO调用。示例如下： 

 

在变量中定义 Phy_input0变量，不需要定义变量的类型，即可在程序中调用变量。变量的操作可以

按位操作，也可以按字节操作，如下图： 

 

4.5  使用 Glink-I 总线 

iDEABOX Pro（IBX131-804-xxx）控制器集成 Glink-I 总线接口，可以通过 Glink-I 总线接入数字量

IO、模拟量 IO、编码器、计算器等扩展模块。 

1. 在使用 Glink-I总线之前需要先在设备池中安装 GL500设备描述文件，如： 

GL500Master.devdesc.devdesc.xml     Glink-I 总线主站描述文件 

GL500Slave.devdesc.devdesc.xml     Glink-I 总线从站描述文件 
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2. 在工程中添加 GL500主站。首先选中 Device（iDEABOX Pro Target），在其右键菜单中选择添加设备，

弹出“添加设备”选框。如下图所示，在专业设备中选择添加 GL500Master设备。 

 

3. 在工程中选中新添加的 GL500Master设备，在 GL500主站设备下面添加一个 GL500从站设备，如下图： 

 

4. 在工程中选中新添加的 GL500 Slave设备，可以在 GL500 Slave下面添加多个扩展模块，如下图： 

 

5. 新添加的模块按顺序依次显示在设备目录树中，如下图：在 GL500 Slave 设备下方添加了一个

16In16Out 的数字量模块和一个 4In4Out 的模拟量模块。双击设备目录树中的设备名称，可以打开对

应的设备配置选项。 
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在 Internal配置中，可以配置模拟量通道的量程范围。 

在 Internal I/O映射中，可以查看扩展模块对应的物理地址（在地址列），通道类型。至此，可以像

使用本体 I/O一样使用扩展模块。 

4.6  使用 CAN 总线 

iDEABOX Pro系列控制器自带 1路 CAN接口，用户可以通过以下方法接入 CAN设备。 

1. 在使用 CAN设备之前需要先在设备池中安装相应的设备描述文件，如： 

 

2. 在工程中添加 CANBus 设备。首先选中 Device（iDEABOX Pro Target），在其右键菜单中选择添加设备，

弹出“添加设备”选框。如下图所示，在现场总线->CAN总线中选择添加 CANBus设备。 

 

3. 在工程中选中新添加的 CANBus设备，在其下添加一个 CANopen_Manager设备，如下图： 
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4. 在工程中选中 CANopen_Manager设备，可以在其下添加多个 CAN从站设备，如本例中添加一个 SoftLink

的 CAN远程数字量 I/O设备“RT133_1BL00_CAN”。 

 

5. 双击 CANopen_Manager 打开“概述”选项框，取消“使能心跳产生”和取消“启动同步生产”的设置，

把 CANOpen总线配置为异步通信模式。 

 

6. 双击新添加的“RT133_1BL00_CAN”设备，在新打开的概述选项中进行如下设置：配置节点 ID，使能

专家设置，启动节点保护并设置保护时间和声明周期系数，取消启动心跳生产和检查供应商 ID的设

置。 
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在设备配置选项的 Internal I/O映射中，可以查看扩展模块对应的物理地址（在地址列），通道类型。

至此，可以像使用本体 I/O一样使用扩展模块 

 

4.7  接入高速工业相机 

iDEABOX Pro 控制器自带 2 路千兆网口，可用于接入 2 个高速工业相机，如通过千兆网口 GigE 接入

Basler 的高速工业相机等。在 iDEABOX Pro 运行 Basler 相机的示例程序，可见其能长时间运行在满带宽

（100MB/s）状态下不丢帧。 
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可以通过 CODESYS V3.5 的 ActiveX Element 控件来集成基于 QT 开发的相机采集程序以及 UI 界面，

实现运控程序以及相机采集程序的分离，极大缩短产品开发周期。 
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第5章  用户编程示例 

5.1  示例快速实现方法 

示例的实现方法也是控制器编程的基本方法,从系统搭建到编程到下载将轴运行， 

通常需要以下几个步骤: 

1）控制系统搭建; 

2）组态配置; 

3）程序开的操作和步骤； 

4）控制程序编写；  

5）人机界面的编写； 

6）程序编译、调试、下载； 

5.1.1  控制系统搭建 

控制系统的硬件搭建是控制程序正确运行的基础，根据系统要求搭建控制系统的硬件平台，选择相应

的控制器、本地 I\O、伺服驱动器、伺服电机、远程 EtherCAT I\O 等等； 

本实例程序，选用 iDEABOX Pro 控制器，EtherCAT 驱动器和电机；EtherCAT 远程 IO，超五类屏蔽线

（网线）等，进行正确的接线然后上电； 

5.1.2  组态配置 

控制系统搭建完成之后，控制器与从站（从站一般为 EtherCAT 伺服驱动器和 EtherCAT I\O）建立通

讯除了确保物理接线正确，还须确保 EtherCAT 主从站配置文件的正确配置，配置方法如下： 

1） 可以使用“EtherCATConfig.exe 配置工具”进行主从站配置，打开配置工具->右键点击

EthercatMaster->Add Device->选择从站使用的设备描述文件（如果从站中有伺服驱动器和 I\O

模块，则要先配置驱动器然后再配置 I\O），然后点击 Add Device依次添加所有从站。 
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2） 添加好从站后，要对每个从站进行参数配置： 

a) 一般只需要根据从站的类型（驱动器或是 I\O）进行配置：如果从站是驱动器，则在 Save参

数卡中选择 Slave Type为 1：Motion Slave；如果从站是 I/O设备，则选择 0：I/O Slave； 

b) 根据需要配置同步时钟，如果没有特殊要求，使用工具默认的配置选项就可以。如下勾选 DC 

Sync0 Enable将使能 DC Sync0，并且 sync0 cycle time要根据具体系统要求填写，一般默

认为 1ms，sync0 shift time默认为 0.1ms； 

c) 其它参数卡一般使用默认值，具体可以参考<<EtherCAT 配置工具 EtherCATConfig 使用说

明.pdf>>。 
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3） 配置从站的过程中需要删除某个从站，可以右键点击要删除的从站名称，选择 Delete Device 即

可删除。 

4） 所有从站配置完成后保存配置，点击菜单栏中的 Config->Save Ecat Config即可将配置文件保存

到 output文件夹中，将保存好的配置文件 Gecat.eni放置到控制器的 CPAC文件夹中，整个从

站配置就完成了。 

5） 保存的配置文件 Gecat.eni如下图，Slaveindex 下 Value值为表示所挂轴的个数。如更改轴个数，

请更改 Value 值。slave_info 表示轴的信息，1_4_6_Servotronix_CDHD_PC0_Rv01ms 表示驱动设

备型号； 

 

6） 验证配置文件是否成功，可以将配置文件放到控制器的/home/googol/CPACV3 文件夹中，运行

“GRT”，下载应用程序，如果控制器与从站通讯成功，则应用界面中的“Ethercat Ready”状态

等会点亮，指示 EtherCAT通讯成功；请检查配置的从站是否与实际从站个数或类型匹配；控制器

与从站一旦建立起正常通讯，就可以使用控制器的各种功能。 
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5.1.3  安装 Sii 设备描述文件 

进行组态配置的时候需要从站的 Sii 设备描述文件， 如果 Slave Devices 列表中找不到相应的从站

设备，则需要先安装设备描述文件。 

1) 打开“EtherCATConfig.exe 配置工具”->左键点击菜单栏 Options->Import Xml…->打开 Slave 

Install Toolkit->左键点击选项 Browse xml…->选择 xml格式的 EtherCAT从站信息文件->选择

从站的设备型号（根据实际需要进行相应的配置，详细介绍请参照《EtherCAT 配置工具

EtherCATConfig 使用说明.pdf》），然后点击 Install安装该从站设备描述文件，如下图： 

 

2) 安装从站设备描述文件成功之后，可以在“Slave Devices”列表中找到该设备描述文件进行组

态配置，如下图： 
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5.1.4  程序开发的操作步骤 

CODESYS创建项目一般需要以下几个步骤： 

1) 启动 CODESYS 编程系统：开始-> 所有程序-> 3S CODESYS -> CODESYS ->CODESYS V3.5 SP9 Patch 

2；或者直接点击桌面快捷方式启动 CODESYS 编程环境。 

2) 初次启动 CODESYS 编程环境并新建 iDEABOX Pro项目之前需要做的准备工作：a)在设备池中安装

“iDEABOX Pro Target”设备。点击菜单 Tools-> Device Repository-> Install，选择 xml 格

式的设备描述文件进行安装。 
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b)在函数库池中添加 iDEABOX Pro 支持的功能库（库函数的使用说明请参照详细编程手册）：点

击菜单 Tools-> Library Repository-> Install，选择相应的库进行安装。 
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3) 新建项目：点击菜单 File-> New Project-> 选择 Template Projects为 Standard project，输

入项目名称和项目目录，点击 Ok打开 Standard project对话框-> 选择 iDEABOX Pro Target控

制器和 PLC_PRG 的编程语言（PLC_PRG 是 CODESYS 默认的 Main Task，整个程序将从此入口开始

运行，编程语言可以选择为 IL、LD、FBD、SFC、ST、CFC，这里我们选择结构化文本 ST），点击

OK创建工程。 
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4) 确认新建项目之后，项目名称显示在 COSESYS 标题栏，Devices 视图栏显示如下图所示的树形结

构。 

 

5) 在项目中添加功能库：项目创建后会自动添加 CODESYS标准库 Standard.library，其它功能库

需要手动添加，鼠标左键点击 Devices 视图栏中的 Library Manager-> Add library 添加库。 
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6) 添加本地 I/O 设备：a.点击菜单 Tools-> Device Repository-> Install在设备池中安装本地 I/O

设备描述文件 GoogolProIO-xxx-xxx.devdesc.devdesc.xml。b.选中设备目录树中的目标设备

iDEABOX Pro Target… -> 右键菜单选择 Add Device-> 添加本地 I/O 设备 IO-IBX131-xxx。c.

通过 Internal配置对新添加的 I/O设备进行设置，比如设备模拟通道的量程等。 d.在 Internal 

I/O映射中定义和操作输入输出变量。具体操作请参考第 4章 4.2软件配置和 4.4使用本地 I/O。 

 

7) 程序的编写：完成建立新项目的准备工作之后，可以打开 PLC_PRG开始编写程序。本示例实现的

功能可以通过查看源程序代码，其中各个运动功能代码请参考 iDEABOX Pro编程手册，在此不再

对程序源码进行详细说明。 
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8) 人机界面的编写：鼠标右键点击 Devices视图栏中的 Application-> Add Object-> Visualization

添加可视化界面（详细使用可参考 CODESYS 帮助文档 CODESYS Visualization。 

5.1.5  程序编译、调试、下载 

1） 程序编写完成后，需要对程序进行编译，点击菜单 Build-> Build，或者按 F11快捷键。 

 

2） 模拟调试：程序编译完成后，点击菜单 Online-> Simulation，然后点击菜单 Online-> Login，

点击菜单 Debug-> Start，或按快捷键“F5”，使程序运行，即可通过模拟界面调试；其中“F9”

是设置/取消断点，如图，“F8”和“F10”是单步跳入和单步跳过。 

 

3） 连接目标设备：a)点击菜单 Online-> Simulation 取消模拟调试前面的勾选；b)启动目标系统：

控制系统上电，控制器自动运行 GRTV3（GRTV3 在控制器的/home/googol/CPACV3 目录下，分为

Ethercat 实时运行环境 MCExtension 和 CODESYS Application 两个进程）；c)通讯连接设置：在

Devices 视 图 栏 双 击 Device(iDEABOX Pro Target)-> Communication Settings-> Scan 

Network…-> 选择目标设备进行连接。 
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或者直接输入目标设备的 IP地址进行连接，连接成功将会在右下角显示绿色圆圈，表示已经建立

连接。 

 

4） 在线调试：与连接设备连接成功之后，执行命令 Online-> Login，或者按快捷键“Alt+F8 ”登

录目标系统-> Start或者按快捷键“F5”运行程序，此时观察控制器的实时运行环境 MCExtension

将输出如下打印信息，显示 EtherCAT 从站配置成功与否（主要的打印信息解析请参照附录）。 
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5） 控制器程序（带界面）下载成功并运行之后将会显示 CODEYSE Application 界面，详细的操作说

明请参考下一节示例简介。 

 

5.2  示例简介 

5.2.1  界面介绍 

该示例是基于 CODESYS 编写的 SOFTLINK 控制器 iDEABOX Pro 的功能演示软件，通过该软件可以查看

和监控控制器状态，测试控制器不同功能模块。 

控制器上电的时候 GRTV3会自动运行，并且启动 CODESYS应用程序；也可以通过 CODESYS 下载程序然

后点击“运行”或按 F5 快捷键启动应用程序，软件可视化界面如图 4-1--4.10 所示，点击界面下方按键

可切换不同界面和模式。界面的左侧显示轴的状态信息，包括轴数据的读取，状态，规划等；右侧为各个

轴模式的数据曲线和，运动参数和控制选项。 

应用程序启动的主界面为点位运动模式 P2P 的可视化界面，控制器与驱动器的通信状态可以查看左侧

轴状态栏中的 EtherCAT Ready 状态灯，如通信正常则状态灯显示绿色；EtherCAT 通信成功之后，示例程

序会自动上伺服，Servo On/Off状态灯亮表示上伺服，灯灭表示下伺服，Motion/Stop状态灯亮表示轴在

运动，灯灭表示轴停止；状态栏中显示的是 Axis 中设置轴的状态信息，可以通过修改 Count 的值，使得

Servo ON（上伺服）、Servo OFF（下伺服）、Clear Status（清除状态）、Clear Position（清除位置）等

按钮操作对多个轴有效。 

P2P运动模式：P2P Axis表示点位运动当前轴，Axis Count表示运动轴计数（当前轴指的是，如果当

前轴为“1”，那么界面会显示“1”轴的相关信息；运行计数功能，指的是当用户需要进行多个轴同时运

行时，例如：用户需要从第 1轴开始往后 3个轴同时运行点位模式，那么当前轴应该设置为“1”，轴运行

计数设置为“3”，指的是从 1 轴开始往后数 3 个轴可同时操作）；其他运动参数请参考点位运动模式编程

手册；Reversing选中表示点位运动会在正反 Target Pos（目标位置）之间往返运动；PosDiff和 MaxPos 

Diff分别表示当前点位运动位置偏差和最大位置偏差（规划位置-编码器位置差值）。 
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图 5-1 iBoxProDemo 界面 1 

 

    JOG运动模式：Jog Axis 表示 Jog运动当前轴，Jog Axis Count表示运动轴计数；其他运动参数请参

考 Jog运动模式编程手册；Reversing选中表示 Jog运动与设定速度持续进行往返运动。 
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图 5-2 iBoxProDemo 界面 2 

 

    PT 运动模式：PT Axis 表示运动当前轴；应用程序默认添加了三组 PT 数据，用户也可以安装需要修

改和添加数据。 
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图 5-3 iBoxProDemo 界面 3 

 

    齿轮运动模式：Slave Axis表示齿轮运动的从轴（Trace图中蓝色速度曲线），Master Axis 表示齿轮

运动的主轴（Trace图中绿色速度曲线）；齿轮运动参数参考运动编程手册。 
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图 5-4 iBoxProDemo 界面 4 

 

Follow 运行模式：Slave Axis 表示跟随运动从轴（Trace 图中蓝色速度曲线），Master Axis 表示跟

随运动主轴（Trace图中绿色速度曲线）；跟随模式默认添加三组数据，用户可以根据需要设计数据；跟随

运动参数参考编程手册。 

 



第 4 章  用户编程示例 

    © 2017 Softlink Copyright 
 

56 

 

图 5-5 iBoxProDemo 界面 5 

 

    插补运动模式：Interpolation Status 显示插补状态和各个轴的运动位置信息；Coordinate Setting 设置

插补坐标系；右侧可以根据需要插入插补数据和前瞻运算等功能；插补运动参数参考编程手册； 
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图 5-6 iBoxProDemo 界面 6 

 

    PVT 运动模式，Axis In Action表示 PVT运动当前轴；程序默认插入 6组 PVT数据，用户可以根据需

要进行设计；启动顺序 Set PVT-> Start PVT。 
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图 5-7 iBoxProDemo 界面 7 

 

    PVT Complete 运动模式：点击 Table 标题框可以切换到 PVT Complete 运动模式；例程的位置和时间

关系由函数 P=40000sin
2
 (π/2000*t)确定，描述了一个正弦变化的速度曲线。 
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图 5-8 iBoxProDemo 界面 8 

 PVT Percent运行模式：该例程实现了 X轴（Trace图中蓝色速度曲线）往复运动，Y轴（Trace图中

绿色速度曲线）正向进给；X轴加减速时 Y轴正向进给，X轴匀速运动时，Y轴保持静止。 
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图 5-9 iBoxProDemo 界面 9 

 

 PVT Continuous运动模式：该例程实现了 X轴（Trace 图中蓝色速度曲线）从 A 点运动到 B 点，Y 轴

（Trace 图中绿色速度曲线）从 C点运动到 D 点，当 X轴到达 B点时，Y 轴同时到达 D 点；选中 Continue

按钮可以循环测试，从 Trace图中可以看到 X、Y轴同时停止运行。 
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图 5-10 iBoxProDemo 界面 10 

 

 IO 界面：演示了 iDeaBox Pro 本地 I/O 和外接远程 Ethercat I/O 的界面，点击相应的输出口可以输

出信号，Ethercat I/O的使用参考编程手册。 
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图 5-10 iBoxProDemo 界面 11 

表格 4-1 Status界面常用输入输出和按键介绍： 

输入输出和按键 意义 

当前轴（Axis） Status界面中其他信息均为当前轴信息，默认为 1，最大为 16。 

轴运行计数（Count） Count默认为 1，最大为 8；1表示单轴运动，根据当前轴的值确定轴

运行计数的值，例如：当前轴=3，轴运行计数=6，指的是从轴 3开始，

向后数 6 个轴，即可同时对 3-8轴上下伺服，停止，清零，清报警等

操作。 

轴状态值（Axis Status） 读取当前轴状态。 

编码器位置值（Enc Pos） 读取当前轴编码器位置。 

规划位置值（Prf Pos） 读取当前轴规划位置。 

编码器速度值（Enc Vel） 读取当前轴编码器速度。 
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输入输出和按键 意义 

规划速度值（Prf Vel） 读取当前轴规划速度。 

轴运动开始时间（Motion Start 

Time） 

显示当前轴开始运动的系统时间。 

轴报警时间（Axis Alarm Time） 显示当前轴驱动器报警的系统时间。 

驱动器报警标志（Axis Alarm） 当前轴连接的驱动器报警时灯亮。 

电机使能标志（Servo On/Off） 当前轴驱动器上伺服时灯亮，下伺服时灯灭。 

规划运动标志（Motion/Stop） 当前轴规划运动时灯亮。 

上伺服（Servo ON） 一个或多个轴上伺服。 

下伺服（Servo OFF） 一个或多个轴下伺服。 

清状态（Clear Status） 清除一个或者多个轴报警标志，限位触发标志，跟随误差越限标志。 

清零（Clear Position） 清零规划一个或多个轴位置和实际位置。 

表 4-1 

注：可通过波形图查看规划速度和编码速度的曲线； 

5.2.2  控制界面操作示例 

以 JOG模式为例，开启 16轴同时运动，运动之前先确保正确配置组态并且连接的各轴状态正常。 

1) 程序下载成功，运行，进入 JOG模式界面。查看 Status栏信息，确保 EtherCAT ready 状态灯亮；

此时正常情况下控制器连接的各轴驱动器会自动上伺服，Axis Status 显示为 16#0200，Servo 

On/Off灯亮，表示上伺服成功；可以将 Axis值进行修改切换，查看各轴的运行状态和轴信息。 

2) Status 栏设置：Axis 值为 1，Count 为 16，可以同时操作 16 个轴的清状态、清零、上伺服、下

伺服灯操作。 

3) Jog运动参数设置：Jog Axis设置为 1，Jog Axis Count值为 16，根据实际需要设置 Acc、Dec、

Smooth Time和 Target Vel的值。 

4) 点击“Start”键，此时驱动器所连接 16 个轴都同时运动；如果点“Start”之前先选中“Reversing”，

则各轴将会持续进行往返的 Jog 运动；此时查看 Status 栏 Axis Status 值为 16#0600，并且

Motion/Stopped 灯亮，表示规划运动成功。 

5) 点击“Stop”键，各个轴减速停止，此时 Status栏 Axis Status的值为 16#0200，Motion/Stopped

灯灭，表示规划运动停止。 
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注：其他模式可同样操作。 
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第6章  附录 

6.1  主要打印信息解析 

打印信息 意义 

No EtherCAT slave connected,run 

in offline. 

未扫描到 EtherCAT Slave；请检查通讯线缆是否连接或 EtherCAT 

Slave是否上电。 

EtherCAT Config ERROR: Loading 

Config File Fail 

缺失 Ecat配置文件 Gecat.eni或者配置文件损坏。 

EtherCAT Config ERROR:Only X 

Slaves are online,you configure Y 

slaves 

配置文件中所配置的从站数目 Y大于实际连接的从站数 X；使用配置

工具修改配置文件使其与实际连接的从站对应。 

EtherCAT Config ERROR:Slave X 

position is not correct或者 Slave 

X product code is not correct.

或者 Slave X vendor ID is not 

correct 

配置文件中第 X从站的拓扑位置或 Product Code或者 Vendor ID与

实际连接的从站不能对应；需要检查配置文件中第 X从站的配置文件

(*.sii)文件是否与实际从站一致。 

 

EtherCAT Config: Start Config X 

ECAT slaves 

显式的提示当前配置了 X个从站。 

 

EtherCAT ERROR 0-X: SDO 

configuration failed.0 

第 X个从站 SDO启动参数配置失败，协议栈终止运行；请检查驱动器

是否支持 CoE协议，或者从站处于某种错误无法响应控制器的配置，

关闭 GRT 并重新启动或者对从站进行重新上电。 

EtherCAT  0：All slaves are in OP 

mode 

提示所有从站已经进入 Operation Mode，可以安全的进行 PDO 或者

SDO通讯，程序可以正常运行了。 

Miss ECAT Stack files 缺失 Ecat库文件，请检查 CPAC 文件夹的文件是否完整。 

Motion Card Init Fail 硬件错误，检查不到运控卡；请检查固件或者硬件是否正常。 

No Slave was configured. 没有 EtherCAT从站被配置，出现此打印信息有两种可能，1)系统本

身就没有 EtherCAT从站 2)系统有 EtherCAT从站但是 CPAC中没有配

置文件 Gecat.eni，或是有这个文件，但是 SlaveIndex 中的 Value

值为 0； 

 

Failed to recerve AL state 

datagram:Datagram timed out 

控制器与从站通讯中断，检查网线是否接触好。 
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6.2  控制器尺寸图 

 

 

  

iDEABOX Pro 控制器尺寸图 单位(mm) 
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